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File Explorer is one of the most crucial tools in Windows 11, as it lets you browse and manage files stored on your computer. This is the tool that allows you to browse all the files on your PC, so you can open, delete, rename them, and much more. If you've been using Windows laptops for a while, using File Explorer may feel like second nature to you,
but you might be surprised at just how much you don't know. And if it's the first time using Windows in a while, then there's a lot you'll want to learn about. This guide will show you everything you need to know to get to grips with it, from the most basic functionality to more advanced settings even more frequent users may not know. This guide is
based on the latest version of File Explorer in Windows 11 version 23H2 and newer. Older versions may look different, but the core functionality is similar. Related Want to customize your context menus? Here's how How to open File Explorer You can open File Explorer on Windows 11 in a few ways: Option 1: Click the File Explorer icon on the
taskbar Option 2: Press Windows + E on your keyboard Option 3: Open the Start menu and search for File Explorer Option 4: Press Windows + R to launch the Run window and then enter explorer Option 5: Right-click the Start button and select File Explorer When you first open File Explorer, there are a few main Ul elements you'll want to take note
of. Let's take a look at the main File Explorer window. There are a few primary elements you'll want to get familiar with here: Tab bar: You'll see the titles of your open tabs and you can switch between them here (only available in Windows 11 version 22H2 or newer). Navigation buttons: Includes back, forward, up, and refresh buttons. Address bar:
Shows the current path in the main view and lets you navigate the folder structure. Search bar: Lets you search for items in the current view (including sub-folders). Ribbon: The ribbon contains file management tools like copy, cut, delete, and rename, as well as filtering and sorting options for your current view. Options shown in the ribbon
depending. Navigation pane: Shows the folder structure of your PC and highlights the current folder in the main view. Main view: Shows you the files and folders in the path you're currently in. You can double-click a file or folder to open it. Navigate to the folder or file you want to copy. Right-click the file or folder and choose Copy from the context
menu. Alternatively, click the file once and then press Ctrl + C to copy it, or click Copy in the ribbon. Navigate to the folder where you want to copy the file. Right-click an empty area of the main view and choose Paste. You can also press Ctrl + V to paste a file, or click Paste in the ribbon. Navigate to the folder or file you want to move. Right-click the
file or folder and choose Cut from the context menu. Alternatively, click the file once and then press Ctrl + X to cut it, or click Cut in the ribbon. Navigate to the folder where you want to move the file. Right-click an empty area of the main view and choose Paste. You can also press Ctrl + V to paste a file, or click Paste in the ribbon. If you have
multiple windows or tabs open, you can also click and drag a file from one location to another to move them. Navigate to the file you want to delete Right-click the file and click Delete. You can also click the file and click Delete in the ribbon, or press the Delete key on your keyboard. Using tabs in File Explorer works similarly to how most modern web
browsers work. Here's how it works: Open a new tab Option 1: Click the + (plus) button in the tab bar. Option 2: Press Ctrl + T on your keyboard. Open a folder in a new tab Option 1: Right-click a folder in the main view or navigation pane and click Open in new tab Option 2: With a desktop mouse, click the scroll wheel (middle-click) a folder to open
it in a new tab. Close a tab Option 1: Click the small X button next to the tab title (not to be confused with the large X in the top right corner of the window). Option 2: Press Ctrl + W on your keyboard to close your active tab. Option 3: With a desktop mouse, click the scroll wheel (middle-click) an open tab to close it. Re-order tabs Option 1: To move
tabs on the tab bar, click and drag them to the position you want them in. Option 2: To move tabs to a separate window, click and drag the tab outside the File Explorer window, then release it. Move files between tabs Click and hold the file or folder you want to move. Drag it over the tab you want to move it to and hold it until the main view switches
to that tab. Drag the file to the main view. File Explorer hides extensions for known file formats by default. If you'd like to see them, use these steps: Click the View option in the ribbon Hover over Show and then choose File name extensions. Certain files can be hidden from view in File Explorer. To see them, do this: Click the View option in the
ribbon. Hover over Show and then choose Hidden items. The Home page in File Explorer shows the files and folders that are most relevant to you across three sections: Quick Access, Favorites, and Recent: Pin or unpin folders from Quick access Quick access contains your pinned folders as well as frequently visited folders. A few folders are pinned by
default, like Pictures, Videos, and Downloads. To unpin a folder you don't want to see here: Right-click the folder you want to unpin. Click Unpin from Quick access. On the other hand, to pin new folders to Quick access, follow these steps: Navigate to the folder you want to add to Quick access. Right-click the folder and choose Pin to Quick access.
Hide frequent folders from Quick access To hide frequently visited folders from the Quick access section, do this: Click the ellipsis icon in the ribbon and choose Options. Uncheck the box labeled Show frequently used folders. Click OK. This way, you'll only see pinned folders. Add files to Favorites Similarly to pinned folders, you can add individual
files to your favorites to have them appear on the Home page. Navigate to the file you want to add to your favorites. Right-click it and choose Add to Favorites. You'll now see it under the Favorites section of the Home page. To remove a favorite file, right-click it and choose Remove from Favorites. Hide recent files Finally, the Recent section shows
files you've recently opened. If you don't want this section to appear, follow these steps: Click the ellipsis icon in the ribbon and choose Options. Uncheck the box labeled Show recently used files. Click OK. Hide online files The Recent section can also show documents you have stored in OneDrive. If you only want to see local files: Click the ellipsis
icon in the ribbon and choose Options. Uncheck the box labeled Show files from Office.com. Click OK. If you don't like the new context menu in Windows 11's File Explorer: Right-click any folder or file you want to act on. Click Show more options. Alternatively, you can hold Shift on your keyboard and right-click with the mouse to see the classic
context menu right away. Related The new context menu isn't for everyone Using File Explorer in Windows 11 is like opening a treasure chest of your digital world. First, click the File Explorer icon on your taskbar or press the Win + E keys on your keyboard to open it. You'll see a sidebar on the left with quick access to your most-used folders like
Downloads, Documents, and Pictures. Navigate through your files and folders by clicking on them. You can also use the search bar on the top right to find a specific file. With this guide, managing your files on Windows 11 will be as simple as pie. File Explorer in Windows 11 is your go-to tool for accessing and managing files. Here’s a step-by-step
tutorial to navigate it like a pro. Click the File Explorer icon on your taskbar. If the icon is missing, press Win + E on your keyboard to open File Explorer instantly. Look at the left side of the window for the sidebar that lists your folders. The sidebar is handy for quick navigation. It lists folders like Quick Access, OneDrive, and This PC. Click any folder
to open it. Click on ‘Quick Access’ in the sidebar to view frequently used files and folders. Quick Access compiles the files and folders you often use, making it a fast way to find what you need without digging through layers of folders. Double-click any folder name to open and view its contents. This action allows you to drill down into folders to find the
specific files you need. You can always go back by clicking the back arrow in the top left corner. Type the name of the file you're looking for in the search bar at the top right. The search function is powerful, saving you time by filtering through your files to find exactly what you need in a jiffy. Once you complete these steps, you will have explored the
basics of File Explorer in Windows 11. You now know how to open it, navigate quickly to frequently used folders, and use the search function to find specific files. Customize the Quick Access toolbar for even faster navigation by pinning your most frequently used folders. Use the right-click menu to cut, copy, or paste files to organize them exactly how
you want. Enable the preview pane from the View tab to see a preview of files before opening them. Use the ‘Sort by’ and ‘Group by’ options to organize files by date, type, size, or other properties. Create new folders by right-clicking in the main window pane and selecting ‘New’ > ‘Folder’ to organize your files better. File Explorer is used for
navigating, accessing, and managing files and folders on your computer. It’s your main hub for file management. You can quickly open File Explorer by pressing Win + E on your keyboard or clicking the File Explorer icon on your taskbar. Yes, you can customize it by right-clicking on your favorite folders and selecting ‘Pin to Quick Access’. Use the
search bar at the top right of the File Explorer window to type in the name of the file you’re looking for. Yes, you can enable the preview pane from the View tab to see a preview of files in certain formats before opening them. Open File Explorer using the taskbar icon or Win + E. Locate and use the sidebar for navigation. Click Quick Access for
frequently used files. Double-click folders to view contents. Use search to find specific files. Navigating File Explorer in Windows 11 doesn’t have to be a daunting task. With the steps and tips outlined in this guide, you can become the master of your digital files. Remember, the more you use these features, the more intuitive they will become. File
Explorer is not just a tool; it’s like your personal assistant, helping you keep your digital life organized. Explore different views, customize your Quick Access, and don’t shy away from using the search function - it’s there to make your life easier. If you’ve found this guide helpful, why not dive deeper into the world of Windows 11? There’s a lot more to
learn, and every feature is designed to make your computing experience smoother. Are you ready to explore what’s next? Matthew Burleigh has been writing tech tutorials since 2008. His writing has appeared on dozens of different websites and been read over 50 million times. After receiving his Bachelor’s and Master’s degrees in Computer Science
he spent several years working in IT management for small businesses. However, he now works full time writing content online and creating websites. His main writing topics include iPhones, Microsoft Office, Google Apps, Android, and Photoshop, but he has also written about many other tech topics as well. Read his full bio here. Microsoft has
completely redesigned the File Explorer in Windows 11. It’s got a sleek and refreshing interface, a Command Bar at the top with the relevant icons, an uncluttered context menu, however, Microsoft has not done away with the legacy context menu and it can still be accessed. With a plethora of changes, it would take you some time to get acquainted
with them all. But once you do, working on Windows would be much simpler and convenient. We did expect some changes in the File Explorer, most are there on Windows 11 while the wait for others continues. Let’s see what all changes are introduced to the new File Explorer and how to perform various actions and functions on it. File Explorer
Interface When you first launch File Explorer on Windows 11, it’s a refreshing feeling. With a clean look coupled with a centered Taskbar, Microsoft has no doubt got the interface right. There’s the new Command Bar at the top, with just the relevant icons. Since the number of options that could be directly accessed are far less, the Command Bar
occupies lesser space. Then there are new icons, bright and appealing (these are also present in recent Windows 10 updates as well). We have some addition to the icons as well. On the first look, it appears to be a complete overhaul of File Explorer. Let’s delve deeper, identify the other changes, and learn how to use the new File Explorer. Command
Bar The Command Bar at the top is pretty neat with just the icons to perform relevant tasks. Unlike the previous versions which had options categorized under three tabs, here (in the new command bar) all the options can easily be accessed. Also, the options in the Command Bar depend on the type of file you have selected. In case it’s an image the
option to ‘Set as Background’ and ‘Rotate right’ will be added, while for most of the other file formats and folders, it remains the same as below. Let’s see how you perform actions with the Command Bar. Creating a New Folder or Item To create a new folder or item, click on the ‘New’ option at the extreme left of the Command Bar. In the drop-down
menu, you have two options, either to create a folder or add a new item. The first option, i.e. ‘New folder’, is self-explanatory, but if you hover the cursor over ‘New Item’, a new menu with a list of items will appear, although, there is a ‘Folder’ option here as well. Cut, Copy, or Paste a File or Folder To copy and paste a file or folder, select the file and
click on the relevant icon in the Command Bar. Once you have either cut or copied a file, the ‘Paste’ icon won't be greyed out anymore. Navigate to the location where you want to paste the file and click on the ‘Paste’ icon in the Command Bar. Rename a File Folder To rename a file or folder, select the file you want to rename, click on the ‘Rename’
icon from the Command Bar or right-click on the file and click on the Rename icon there. Then, enter a new name for the file, and press ENTER. Delete a File/Folder To delete a file on the new File Explorer, select the file(s), and click on the ‘Delete’ icon at the top or right-click on the file and click on the Delete icon in the context menu. Share Files
from the File Explorer To share files with the new File Explorer, select the file, click on the ‘Share’ icon and three options will appear on the screen. Nearby sharing: You can use this feature to share files with other nearby Windows devices. Just enable the feature on both the devices and share files between the two.Email a contact: If you have set up
the ‘Mail’ app on Windows 11, your contact list will be displayed here and you can share the file over email.Share with app: This option helps you share files over apps installed on your computer. Sort and Group Options Windows 11 has made sorting and grouping the files and folders a lot simpler and convenient. Just click on the ‘Sort and group
option’ icon and the first four options would be to sort the files/folder. If you don’t want to sort the files according to the first three, hover the cursor over ‘More’ and select another sorting option. The option that’s currently set has a dot before it. The next two options, ‘Ascending’ and ‘Descending’, decide the sort order. Ascending: The files with the
lowest value of the sorting parameter are listed at the top.Descending: The files with the highest value of the sorting parameter are listed at the top. The last option ‘Group by’ help you group the files and folders. Hover the cursor over the option and a new menu with various grouping choices will appear. Select the desired one from the list. Layout
and View Options The penultimate option in the Command Bar is the ‘Layout and view options’. It helps you choose the layout for the files and folders and to select which files are to be displayed. When you click on the ‘Layout a view options’ icon in the Command Bar, it launches a drop-down menu. The first eight options in the drop-down menu
decide the layout for the various files/folders for the location that’s currently open. When you select ‘Compact view’, the space between the various items decreases. It applies both to the items listed in the folder and those in the navigation pane. The last option, i.e., Show, lists the various panes, features and items that can easily be enabled or
disabled. For instance, if you want to add ‘Checkboxes’ to the files/folders for easy selection, choose the option. Or if you want to view the hidden files, select the ‘Hidden items’ option. The options did exist earlier, they have just been positioned differently on Windows 11. More Options The last icon in the Command Bar is the ellipsis which opens a
drop-down menu that lists several extra options. The number of options varies depending on whether a file or folder has been selected or if none has been selected. When you select a file, another option ‘Copy path’ with added under ‘More options, and in the case of a folder, the option ‘Compress to ZIP file’ will be added, in addition to ‘Copy path’.
The options here are all self-explanatory and you will get a hang of each within a few moments. New Context Menu Gone are the days of a messy context menu where locating an option seemed like a task in itself, let alone performing the action. Windows 11 has introduced a new simplified Context Menu, one where all the icons and options can be
distinguished in a single glance. We now have icons for multiple actions in the context menu. However, for those of you who prefer the legacy Context Menu, it can still be accessed on Windows 11. Microsoft has not removed it from the latest version, however, the new Context Menu is much simpler and easy to work on. Let’s see the various options
in the new context menu. Note: As was the case with Command Bar, the options in the context menu depends on whether you have selected a file or a folder, and the file format. The icons for cut, copy, paste, rename, and delete, that were present in the Command Bar are added to the new context menu as well. These icons can be present either at
the top or bottom of the context menu. Users who still have their hands set on Windows 10 can access the legacy context menu by selecting ‘Show more options’ or press SHIFT + F10. The other options in the context menu are self-explanatory. Navigation Pane As discussed earlier, there have been no major changes to the Navigation Pane on the left.
It works the same way as those in the previous versions, helping you quickly navigate through the various folders on the system. You can pin items to Quick Access to have them accessible with a single click. However, when you right-click on any item in the Navigation Pane, it launches the new context menu, the one we saw earlier. Improved Theme
Support in File Explorer For those of you who like to experiment with themes to enhance the Windows experience, Windows 11 surely has a lot to offer. Check out the various themes in the ‘Personalization’ settings. Like the Dark theme, it’s not new (has been in Windows 10 too), but it’s much better now in Windows 11. To change themes in Windows
11, press the Windows logo key to launch the ‘Start Menu’, enter ‘Settings’, and then click on the relevant search result to launch the app. In Settings, click on ‘Personalization’ at the left. Now, you can either select one of the themes listed at the top or select the “‘Themes’ option to customize the theme or download more from the Store. We tried the
dark theme on Windows 11 and it works like a charm for File Explorer. Troubleshooting Issues with the New File Explorer Many users who have switched to Windows 11 reported being unable to access the new File Explorer, instead, it was the old File Explorer that launched. If that’s the case with you, here are some quick and effective fixes. 1.
Restart the Computer Restating the computer helps fix most of the trivial errors. When you restart the computer, the OS is reloaded which fixes any minor glitch that was preventing access to the new File Explorer. After restarting the computer, check if get access to the new File Explorer. In case it’s the old one that loads, move to the next fix. 2.
Change File Eplorer Options There’s a setting to launch folder windows in a separate process for File Explorer. In case it’s enabled, Windows 11 will launch the old File Explorer. Here’s how you disable it. Press the WINDOWS key to launch the ‘Start Menu’, search for ‘File Explorer Options’ and then click on the relevant search result. Next, navigate
to the “View’ tab, locate ‘Launch folder windows in a separate process’, untick the checkbox for it and finally click on ‘OK’ to save the changes. Now, check if you are able to access the new File Explorer. 3. Uninstall Link Shell Extension The Link Shell Extension application has been found to cause this issue on Windows 11. If you have it installed on
the system, uninstall it and check if the error is fixed. 4. Update Graphics Driver If none of the above fixes have worked, it’s time you update the Graphis Driver. Running an outdated version of the driver can also lead to errors and affects the performance of the system as well. To update the Graphics Driver, go to ‘How to Update Drivers in Windows
11° and check the ‘How to Update Graphics Driver in Windows 11’ section. After updating the Graphics Driver, check if the error is fixed and you are able to access the new File Explorer. In all likelihood, the above fixes should resolve the error. But, in case it persists, you have no option but to wait for an update. With each update, Windows try and fix
the various bugs. Wait and see if the error is fixed in the subsequent updates. That’s all there’s to the new File Explorer on Windows 11. Just keep exploring the various options and settings and you will get acquainted with the new interface in no time. File Explorer is an essential part of Windows 11 that helps you manage your files and folders. But, if
it's not pinned to your taskbar, it isn't always obvious how to launch it. Here are five easy ways to launch File Explorer in Windows 11. The Fastest Way: Press Windows+e ojovago\/Shutterstock"> ojovago/Shutterstock At any time while using your PC, press the Windows key and the "E" key together, and a File Explorer window will pop up
immediately. It can't get easier than that! This shortcut also works in Windows 10 and extends all the way back to Windows 95. If you right-click the Start button in your taskbar (or press Windows+x on your keyboard), a hidden "power user" menu will appear. Select "File Explorer" from the list, and File Explorer will open. You can also find File
Explorer in the Start menu. To do so, click the Start button on your taskbar, then type "file explorer" on your keyboard. When you see the "File Explorer" result, either click its icon or simply press Enter, and File Explorer will launch. You can also open File Explorer from the command line. After opening a Command Prompt, type "explorer.exe" or just
"explorer" and hit Enter. A File Explorer window will open to your "This PC" location. The same trick works if you type "explorer.exe" into the Windows+r "Run" box. In Windows 11, you can add a special shortcut to File Explorer that lives in your Start menu. To do so, open Windows Settings (press Windows+i), then navigate to Personalization >
Start > Folders. On the Folders screen, flip the switch beside "File Explorer" to "On." The next time you open Start, you'll see a small outlined File Explorer icon beside the power icon at the bottom of the menu. Click it, and File Explorer will open. Happy exploring! Windows File Explorer serves as your gateway to managing files and folders on your
computer. When it stops working properly, your entire workflow comes to a halt. This comprehensive guide provides practical solutions to common File Explorer problems and shows you where to find help when you need it most. File Explorer is Windows’ built-in file management application that lets you browse, organize, and access files on your
computer. It’s essentially your digital filing cabinet, helping you navigate through folders, copy files, and manage your storage space efficiently. Every Windows user interacts with File Explorer daily, whether they’re opening documents, managing downloads, or organizing photos. When File Explorer malfunctions, it affects your ability to perform
basic computer tasks, making quick resolution crucial for productivity. File Explorer consists of several key elements that work together to provide file management functionality: ComponentFunctionCommon IssuesNavigation PaneShows folder hierarchySlow loading, missing drivesAddress BarDisplays current locationPath errors, navigation
problemsRibbon MenuProvides file operationsUnresponsive buttons, missing optionsPreview PaneShows file contentCrashes, memory issuesStatus BarDisplays file informationIncorrect data, performance metrics Understanding these components helps you identify where problems originate and apply targeted solutions. File Explorer is built into
Windows and doesn’t have separate system requirements. However, optimal performance depends on your system specifications: RequirementMinimumRecommendedRAM2GB8GB or moreStorage500MB free space2GB free spaceProcessorl GHz2GHz dual-coreGraphicsDirectX 9 compatibleDirectX 11 compatible Systems below minimum
requirements may experience slow performance, frequent crashes, or limited functionality in File Explorer. “This Computer” provides direct access to your drives, network locations, and system folders. It serves as the central hub for all storage devices connected to your system. Open File Explorer and click “This PC” in the navigation pane to access
your computer’s drives and folders. You can also set This PC as your default File Explorer location through Folder Options. Personalizing the This Computer view improves your workflow and provides quick access to frequently used locations. You can add custom folders, remove unnecessary items, and reorganize the layout. Right-click empty space in
This Computer and select “Personalize” to modify the appearance. Add network drives by clicking “Map network drive” in the Computer tab of the ribbon menu. Network locations appear in This Computer alongside local drives, providing seamless access to shared folders and cloud storage. This integration simplifies file management across multiple
storage systems. Click “Add a network location” in This Computer to connect to FTP sites, web folders, or other network resources. These connections persist across sessions and appear automatically when File Explorer opens. File Explorer cannot be downloaded as a standalone application because it’s integrated into Windows as a core system
component. It’s included with every Windows installation and cannot be removed or replaced entirely. If File Explorer is missing or corrupted, you need to repair or reinstall Windows components rather than downloading a separate installer. Microsoft doesn’t provide File Explorer as an independent download. When File Explorer becomes severely
corrupted, reinstalling its components through Windows Features or system repair tools often resolves persistent problems. Open “Turn Windows features on or off” through Control Panel, locate “Windows Search” and related components, uncheck them, restart your computer, then re-enable these features. This process reinstalls File Explorer
dependencies. See also 100+ Midjourney Christmas Prompts: Top Notch Prompts for Today! Some File Explorer functionality depends on optional Windows features that may not be installed by default. Installing these features can resolve missing menu options or functionality gaps. Access Windows Features through Control Panel > Programs >
Turn Windows features on or off. Enable features like “Windows Search,” “Internet Explorer,” and “Media Features” to ensure full File Explorer functionality. File Explorer failing to open prevents access to your files and folders, creating significant workflow disruption. This problem typically occurs due to corrupted system files, registry errors, or
conflicting software. When File Explorer won'’t open, try pressing Windows + R, typing “explorer.exe,” and pressing Enter. If this fails, the explorer.exe process may be corrupted and require repair through system tools. Unresponsive File Explorer windows freeze your file management activities and may require forceful closure. This issue often stems
from memory problems, corrupted files, or excessive system load. The explorer.exe process manages File Explorer windows and the desktop environment. When this process encounters errors, it affects system stability and file management capabilities. Monitor explorer.exe in Task Manager to identify unusual behavior like high CPU usage or memory
consumption. Multiple explorer.exe processes may indicate malware infection or system corruption. Quick Access problems prevent File Explorer from displaying recent files and frequently used folders. These issues often result from corrupted history files or indexing problems. Clear Quick Access history and disable automatic folder suggestions if
problems persist. Rebuild the search index through Indexing Options in Control Panel to restore Quick Access functionality. Corrupted explorer.exe files cause File Explorer crashes, desktop problems, and system instability. Repairing these files requires administrative access and system repair tools. Run Command Prompt as administrator and
execute “sfc /scannow” to scan and repair corrupted system files including explorer.exe. This process automatically replaces damaged files with clean copies from Windows installation media. Manual system file replacement provides targeted repair for specific explorer.exe problems when automatic tools fail. This advanced technique requires careful
execution to avoid system damage. Boot from Windows installation media, access Command Prompt, and navigate to the System32 folder. Replace corrupted explorer.exe with a clean copy from the Windows installation source. Registry corruption affects explorer.exe functionality and File Explorer behavior. Repairing registry entries related to File
Explorer often resolves persistent problems. Use Registry Editor to navigate to HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer and verify key integrity. Export registry keys before making changes to enable rollback if problems occur. Proper File Explorer configuration improves performance, security, and usability.
These essential settings form the foundation of an efficient file management environment. Setting CategoryKey OptionsImpactView OptionsShow hidden files, file extensionsSecurity, troubleshootingPrivacy SettingsClear history on exitPrivacy protectionSearch Optionsindex locations, file typesSearch performanceNavigationDefault folder, Quick
AccessWorkflow efficiency File Explorer privacy settings control what information is stored and shared about your file usage patterns. Proper configuration protects sensitive data while maintaining functionality. Disable “Show recently used files in Quick access” and “Show frequently used folders in Quick access” to prevent unauthorized access to
your file history. Clear File Explorer history regularly to maintain privacy. Advanced folder options provide granular control over File Explorer behavior and appearance. These settings affect how files are displayed, accessed, and managed across your system. Enable “Display the full path in the title bar” and “Show status bar” for better navigation
awareness. Configure “Open each folder in its own window” if you prefer multiple File Explorer instances. Effective file organization reduces search time and improves productivity. Implement consistent naming conventions, logical folder structures, and regular maintenance routines. Create a hierarchy no more than three levels deep to maintain
accessibility. Use descriptive folder names that clearly indicate contents without being excessively long. File Explorer’s search functionality goes beyond simple filename matching. Master advanced search operators and filters to locate files quickly across large storage systems. Search OperatorFunctionExampletype:Search by file
typetype:pdfmodified:Search by date modifiedmodified:todaysize:Search by file sizesize:>10MBauthor:Search by file authorauthor:John Batch operations allow you to perform actions on multiple files simultaneously, saving significant time when managing large file collections. File Explorer supports various batch operations through selection and
keyboard shortcuts. Select multiple files using Ctrl+click or Shift+click, then apply operations like copy, move, delete, or rename to all selected items. Use F2 to rename multiple files with sequential numbering. See also Janitor AI vs Character Al: A Detailed Comparison File Explorer contains numerous hidden features that enhance productivity and
provide advanced functionality. Discovering these features transforms your file management experience. Press Alt to reveal classic menu options in File Explorer. Use Ctrl+Shift+N to create new folders quickly. Right-click the File Explorer icon in the taskbar while holding Shift to access advanced options. Quick Access learns from your usage
patterns to provide intelligent file and folder suggestions. Optimizing this feature improves workflow efficiency while maintaining system performance. Pin frequently used folders to Quick Access for permanent placement. Unpin rarely used items to keep the list relevant and manageable. Preview and Details panes provide additional information
about selected files without opening them. These panes enhance productivity by displaying file contents and metadata inline. Enable Preview Pane through the View tab to see document contents, image previews, and media information. Use Details Pane to access file properties, tags, and system information. File Explorer freezing or becoming
unresponsive is the most frequent issue Windows users encounter. This problem typically manifests as a greyed-out window that doesn’t respond to clicks or keyboard inputs. The root causes often include corrupted system files, conflicting software, or excessive memory usage. When File Explorer stops responding, your immediate options are limited,
but several recovery methods can restore functionality without requiring a system restart. Performance degradation in File Explorer creates frustrating delays when browsing folders or opening files. This sluggishness often stems from indexing problems, too many startup programs, or insufficient system resources. File Explorer consuming excessive
RAM indicates underlying issues with system processes or corrupted files. High memory usage slows down your entire computer and may cause other applications to crash. Monitor your Task Manager to identify when File Explorer uses more than 100MB of RAM consistently. Normal usage should keep memory consumption below 50MB for typical
file browsing activities. Working with large files or folders containing thousands of items often triggers performance problems. File Explorer struggles to generate thumbnails, calculate folder sizes, and display file information for extensive collections. Consider organizing large folders into smaller subfolders and disable thumbnail generation for
folders with many media files to improve performance. Restarting the File Explorer process resolves most temporary glitches without requiring a full system reboot. This method clears memory issues and refreshes system connections. Press Ctrl + Shift + Esc to open Task Manager, find “Windows Explorer” in the Processes tab, right-click it, and
select “Restart.” Your desktop will briefly disappear before returning to normal operation. Alternatively, hold Ctrl + Shift while right-clicking the taskbar, then select “Exit Explorer” from the context menu. Open Task Manager, click “File,” select “Run new task,” type “explorer.exe,” and press Enter. File Explorer maintains a history of recently
accessed files and folders to provide quick access through Quick Access. However, this history can become corrupted and cause performance issues. Open File Explorer, click “View” in the ribbon menu, select “Options,” and click “Clear” next to “Clear File Explorer history.” This action removes all Quick Access entries and recent file references.
Quick Access attempts to predict which files you’ll need next, but this feature can slow down File Explorer significantly. Disabling Quick Access often improves performance, especially on older computers. Navigate to File Explorer Options, change the “Open File Explorer to” setting from “Quick access” to “This PC.” This modification forces File
Explorer to open directly to your drives instead of generating Quick Access suggestions. Corrupted folder options cause various display and functionality problems in File Explorer. Resetting these options returns settings to default values and often resolves persistent issues. Open File Explorer, click “View,” select “Options,” and click “Reset Folders”
in the Folder Options dialog. Confirm the action and restart File Explorer to apply changes. System File Checker scans your computer for corrupted Windows files and automatically repairs them. Many File Explorer problems stem from damaged system files that SFC can identify and fix. Open Command Prompt as an administrator by pressing
Windows + X and selecting “Command Prompt (Admin).” Type “sfc /scannow” and press Enter. The scan takes 15-30 minutes and requires an internet connection for file downloads. SFC will report its findings upon completion. If it discovers corrupted files, it attempts automatic repair. Restart your computer after the scan completes to ensure
changes take effect. Deployment Image Servicing and Management (DISM) provides deeper system repair capabilities than SFC. Use DISM when SFC fails to resolve File Explorer problems or reports that it cannot fix certain files. See also Centralized vs. Decentralized Exchanges: What's the Difference?Run Command Prompt as administrator and
execute “DISM /Online /Cleanup-Image /RestoreHealth” to scan and repair the Windows image. This process takes longer than SFC but addresses more complex system corruption. Faulty RAM causes various File Explorer problems, including crashes, slow performance, and data corruption. Windows Memory Diagnostic tests your computer’s memory
for errors that might affect File Explorer stability. Press Windows + R, type “mdsched.exe,” and press Enter. Select “Restart now and check for problems” to begin the memory test. Your computer will restart and run the diagnostic automatically. Customizing File Explorer improves your workflow and reduces the likelihood of problems. Proper
configuration enhances performance while making file management more efficient. Configure the ribbon menu to show only the tools you use regularly. Right-click the ribbon and select “Customize the Ribbon” to add or remove commands based on your needs. Several Windows settings directly impact File Explorer performance. Adjusting these
configurations can significantly improve response times and stability. SettingLocationRecommended ValueVisual EffectsSystem Properties > PerformanceAdjust for best performancelndexing OptionsControl Panel > IndexingExclude large media foldersPower OptionsControl Panel > PowerHigh performance modeWindows SearchSettings >
SearchDisable enhanced search Proper view options prevent File Explorer from consuming excessive resources while maintaining functionality. Configure these settings based on your typical file management activities. Disable “Display file icon on thumbnails” and “Show preview handlers in preview pane” for folders containing many files. These
features consume significant memory and processing power when dealing with large collections. Windows includes comprehensive help documentation for File Explorer and other system components. Access this resource through the Start menu or by pressing F1 while File Explorer is active. The built-in help system provides step-by-step instructions
for common tasks and troubleshooting procedures. Use the search function to find specific topics related to your File Explorer problems. Microsoft Community forums connect you with other Windows users and Microsoft support staff who can provide personalized assistance with File Explorer issues. Visit the Microsoft Community to search existing
solutions or post your specific problem. Include your Windows version, error messages, and steps you’ve already tried for the most helpful responses. When File Explorer continues to cause problems despite troubleshooting efforts, third-party file managers provide reliable alternatives with enhanced features. Popular options include Total
Commander, Directory Opus, and FreeCommander. These applications offer advanced file management capabilities while maintaining compatibility with Windows system functions. PowerShell provides command-line file management capabilities that bypass File Explorer entirely. This approach works well for users comfortable with text-based
interfaces who need reliable file operations. Basic PowerShell commands like Get-ChildItem, Copy-Item, and Move-Item handle most file management tasks. PowerShell scripts can automate repetitive operations and provide consistent results when File Explorer becomes unreliable. Microsoft regularly releases updates that improve File Explorer
stability and performance. Installing these updates promptly prevents many common problems from occurring. Enable automatic updates through Windows Update settings to ensure your system receives the latest File Explorer improvements and security patches. Regular disk cleanup prevents storage related File Explorer problems and maintains
optimal performance. Use Windows’ built-in Disk Cleanup tool monthly to remove temporary files and system cache. Schedule automatic disk cleanup through Task Scheduler to maintain your system without manual intervention. This proactive approach prevents many File Explorer issues before they impact your workflow. File Explorer problems can
significantly impact your Windows experience, but most issues have straightforward solutions. Start with simple fixes like restarting the File Explorer process before moving to advanced troubleshooting methods. Regular maintenance and proper configuration prevent many problems from occurring in the first place. Remember that Microsoft
provides extensive help resources, and the Windows community offers valuable support when you encounter persistent issues. Don’t hesitate to explore alternative file management solutions if File Explorer continues to cause problems despite your troubleshooting efforts. Start by restarting the File Explorer process through Task Manager. If crashes
persist, run an SFC scan to check for corrupted system files. Consider disabling unnecessary File Explorer extensions and reducing the number of files displayed in single folders. Disable Quick Access, clear File Explorer history, and reduce visual effects in Windows settings. Exclude large folders from Windows Search indexing and disable thumbnail
generation for folders containing many files. High memory usage often results from corrupted files, too many open windows, or problematic extensions. Restart File Explorer, clear its history, and check for third-party software that might be interfering with normal operation. Large folders with many files and enabled thumbnail generation also
contribute to increased memory consumption. Yes, several third-party file managers can replace File Explorer’s functionality. However, some Windows features depend on File Explorer, so complete replacement may cause compatibility issues with certain applications. Popular alternatives include Total Commander, Directory Opus, and Files app for
Windows 11. Open File Explorer Options through the View menu, click “Reset Folders” to restore default folder settings, and clear File Explorer history. For complete reset, run “ms-settings:appsfeatures” from Run dialog, find Windows Explorer, and select Advanced Options to reset. Consider creating a new user account for a completely fresh File
Explorer experience. Persistent explorer.exe crashes indicate serious system problems. Run SFC scan and DISM repair tools to fix corrupted system files. Check for malware using Windows Defender or third-party antivirus. Disable startup programs that might conflict with explorer.exe and consider performing a system restore to a point before
crashes began. Disable visual effects through Performance Options, reduce the number of indexed locations, and turn off thumbnail generation for large folders. Set File Explorer to open to This PC instead of Quick Access, disable file preview for media files, and regularly clean temporary files to maintain optimal performance on older hardware. By
Oluwaseun Bamisile Published September 5, 2022 Need help accessing some of the features in Windows 11 File Explorer? This comprehensive guide offers all the help you need regarding File Explorer in Windows 11. I believe providing you with various ways to open File Explorer is the appropriate place to begin this guide. Hence, below are two
methods to open File Explorer on your Windows 11 computer. Follow the procedures and screenshots below to open File Explorer on your Windows 11 PC via search. Click the Search icon on the Windows 11 taskbar. Then, type “file explorer” (without the quotes) in the search field and select the File Explorer app from the search result. After doing
that, File Explorer will open by default on the Quick access page. As the title of this sub-section suggests, you can open File Explorer in Windows 11 by just right-clicking the Start menu. Basically, when you right-click the Start menu, select File Explorer from the options that pop up. You can also open Windows 11 File Explorer via the command
prompt. To use this method to open File Explorer in Windows 11, follow the steps below: Search cmd in Windows 11 search. Then, open Command Prompt from the search results. When the Windows Command Prompt opens, type the command below. Then, press the enter key on your keyboard to open File Explorer from Command Prompt.
explorer.exe This section will explain the Windows 11 File Explorer menus and their functionalities. Windows 11 File Explorer’s visible menu items are seven, and they perform various functions - Cut, Copy, Paste, Rename, Share, Delete, and Sort. The table below explains the functions of these items. S/NVisible Menu ItemsFunctions1Cutlt allows you
to cut selected files or folders in Windows 11 File Explorer2CopyThis allows you to copy a selected file or folder. 3Pastelt allows users to paste a cut or copied file or folder in the same or different location in Windows 11 File Explorer4Renamelt allows users to rename a selected file or folder. 5ShareThis allows users to share a selected file via
email.6DeleteAs the name suggests, this item allows you to delete a selected file or folder in Windows 11 File Explorer7SortThis allows users to adjust how folders or files in Windows 11 File Explorer are sorted. Basically, when you click the Sort drop-down, you can sort folders or files by name, type, date modified, and so much more. As a matter of
fact, you can sort files or folders in ascending or descending order with the Sort drop-down. In the Sort drop-down, you can also group files and folders via the Group by category. You can use the Windows 11 File Explorer View menu to set how files and folders appear. Hence, when you click the View drop-down, you will see various view options - see
the screenshot below. However, there is a unique option among the View drop-down options. This option is the Show option. Basically, if you hover your mouse on Show in the View drop-down, another set of options will appear. Thus, you can enable various items you wish to make visible in Windows 11 File Explorer, such as the Preview pane and
Details pane. You may also disable them by selecting them when they are enabled. To know if an item is enabled in the Show category, you will see a checkmark beside it. The “See More” menu in Windows 11 File Explorer offers various interesting features. In essence, when you click the “See More” icon in Windows 11 File Explorer, numerous items
with various functions will appear. The functions of these items are explained in the table below. S/N“See More” ItemsFunctions1Burn to discThis allows users to burn a selected file in Windows 11 File Explorer to a readable disc 2Pin to Quick access It allows you to pin a selected folder to Quick access in Windows 11 File Explorer3Select allThis
allows you to select all the items in a particular folder opened in File Explorer4Select noneThis clears all your selections in Windows 11 File Explorer5Invert selectionThis reverses all your current selections in Windows 11 File Explorer6PropertiesIt opens the properties of a selected file or folder7OptionsThis is an easy way to open the File Explorer
Option in Windows 11 Keyboard shortcuts improve our productivity while working on a computer. So, this section highlights various File Explorer keyboard shortcuts in Windows 11. File Explorer Keyboard Shortcut Actions Performed by the Keyboard ShortcutCtrl + WClose the active window. The active window is the window you are currently
viewingCtrl + NOpen a new window. If you use this shortcut with a folder open, another window of the folder will open. However, if you press the shortcut with a file active - say notepad - a new file will openCtrl + FSelect the File Explorer search box. This shortcut selects the search box for the open application. For example, if you are on a webpage
when you press this shortcut, it opens a search box on the top right of the webpage. Ctrl + ESimilar to Ctrl + F - select the search box. Alt + DSelect the address bar. If you are on File Explorer, it selects the address bar of File Explorer. However, if you are on a webpage, it selects the address bar of the webpage. Ctrl + mouse scroll wheelChange the
size and appearance of file and folder icons. Ctrl + Shift + EDisplay all folders above the selected folder. Ctrl + Shift + NThis keyboard shortcut creates a new folder. This can be very helpful. Instead of going through 3 steps to create a new folder, you can do it in a single step!Alt + Left arrowUsed to view the previous folder.Alt + Up arrowView the
folder that the current folder was in.Alt + Right arrowView the next folder.Alt + EnterOpen the Properties dialog box for the selected item. This works for Folders or Files. Alt + PThis shortcut displays the preview panel on the right pane of File Explorer. Note that some items may not have a preview. F11 keyMaximize or minimize the open window.
Home keyDisplay the top of the open window.End keyDisplay the bottom of the open window.Left arrow keylf the current selection is expanded, it collapses it or selects the folder the current folder is in. Right arrow keylf the current selection is collapsed, it expands it, or it selects the first subfolder. Backspace keyView the previous folder. As stated
earlier, File Explorer opens to the Quick access page by default. Furthermore, this page displays commonly accessed folders. Interestingly, you can customize this Quick access page in File Explorer. This implies you can pin or unpin a particular folder or item to the File Explorer Quick access. In the following sub-sections, I'll explain the various ways
you can customize Windows 11 File Explorer. It is quite simple to pin a folder to the Quick access page in Windows 11 File Explorer. Simply right-click the folder you wish to pin and select Pin to Quick access from the options that appear. Other File Explorer items you can pin to Quick access include “This PC” and “Network”. Similar to pinning a
folder, to pin these items, right-click the item and select Pin to Quick access from the displayed options. After pinning an item or folder in Windows 11 File Explorer Quick access, you might want to unpin it. Well, this section teaches how to unpin file Explorer items from Quick access. To do that, right-click the pinned item and select Unpin from Quick
access from the displayed options. On the Quick access page in Windows 11 File Explorer, you will see two categories - Folders and Recent Files. The Folders category features pinned items and frequently accessed folders. On the other hand, the Recent Files category features recently accessed files. So, in this section, you will learn how to remove
frequently accessed folders and recently accessed files from these categories. Follow the steps below to remove frequently accessed folders and recently accessed files from the Quick access page in Windows 11 File Explorer. Click the Windows 11 Search icon on the taskbar and type “file explorer options” in the search field. Then, select File
Explorer Options from the search result. Afterward, locate the Privacy category in the General tab on the File Explorer Options window. Then, under this category, uncheck the Show recently used files in Quick access and/or Show frequently used folders in Quick access boxes. Finally, click the OK button at the bottom of the window to save the
changes. Hence, when you open File Explorer Quick access, you will notice the frequently accessed folders and recently accessed files are gone! The Documents folder is arguably one of the most accessed folders on a computer. Hence, in this section, you will learn how to access this folder in Windows 11 File Explorer. By default, the Documents
folder is pinned to the File Explorer Quick access. Hence, once you open File Explorer in Windows 11, you can easily access the Documents folder beneath Quick access. However, if you previously unpinned the Documents folder from your Windows 11 File Explorer Quick access, follow the steps below to pin it. Open File Explorer by right-clicking the
Windows 11 Start menu and selecting File Explorer from the displayed options. Then, select This PC on the left pane of the File Explorer window. Afterward, double-click Local Disk (C:) under the Devices and drives category or the drive your Windows 11 is installed. Next, double-click the User folder to open it. Then, select the folder with the name of
the Windows 11 profile that you are currently logged in. For this demonstration, I will be selecting the Fire Hub 019 folder. Finally, right-click the Documents folder and select Pin to Quick access. This section teaches how to perform various common tasks in Windows 11 File Explorer. If you want to print a file or document while in File Explorer,
right-click the file or document and select Show more options. Then, click Print from the options that appear, and the document should print to your default printer. Impressively, you can also print multiple documents via File Explorer in Windows 11. To do that: 1. Lleft-click the first document to select it. Then, click the other documents you wish to
print together while pressing the Ctrl key on your keyboard. Next, right-click any one of the selected documents and click Show more options. Finally, click Print from the options that appear, and the documents should be sent to your default printer. Although Windows 11 File Explorer doesn’t have an image/photo resize option, Windows 11 Photos
app has a resize option. So, follow the steps below to resize an image via the Photos app in Windows 11. Click the Windows 11 Search icon and type “photos’ in the search field. Then, select the Photos app from the search result. Afterward, click the Import icon in the Photos app and select From a folder. Next, select the folder you want to import the
image from on the Select folder window. Then, click the Import items from this folder button at the bottom of the window. On the Import items page, select the image you want to resize and click the blue import button at the bottom of the page. Following that, select the image you imported, which you plan to resize. Then, click the See more (three
horizontal dots) icon at the top of the window and select Resize. Finally, select a pre-defined size from the options, if available. You may also select Define custom dimensions to resize your image with custom dimensions. There are two ways you can delete an image or photo in Windows 11 File Explorer. You can right-click the photo you want to delete
and select the Delete icon from the displayed options. Alternatively, you can select the image you want to delete by left-clicking it. Then, click the Delete key on your keyboard. In addition to deleting a photo in Windows 11 File Explorer, you can also delete a photo via the Windows 11 Photos app. Follow the steps below to achieve that. After opening
the Photos app in Windows 11, hover your mouse cursor on the photo you wish to delete. Then, check the box at the top right edge of the photo. With the photo selected, click the See more icon at the window’s top right corner and select Delete. Finally, you will receive a pop-up asking if you are sure you want to delete the photo. Click Delete to
proceed. To save any file in Windows 11 File Explorer - WordPad and notepad files - click the File menu at the top left corner of the window. Then, select Save or Save As from the displayed options. Some of our readers reported that when they launch Windows 11 File Explorer, it shows the names of the folders/files. Hence, these readers need help
setting up Windows 11 File Explorer to show folders/files in thumbnail view. To do that, click the View menu on the File Explorer window and select either Extra large icons or Large icons. 6. Increase Text Size Changing the view to the thumbnail is an easy way to increase the size of Windows 11 File Explorer texts. To do that, read the previous
section, How To Change File Explorer To Thumbnail View. However, that changes mainly the view, not particularly the texts in File Explorer. Sadly, Windows 11 File Explorer doesn’t have a built-in function that allows you to increase the size of texts. Thankfully, Windows 11 has a feature that allows you to increase the text size of most applications,
including File Explorer. Hence, follow the steps below to enable this feature. Right-click the Windows 11 Start menu and select Settings. Then, select Accessibility on the left pane of the Settings window. Afterward, click Text size. Finally, with the Text size slider, you can modify the text size in Windows 11. After doing that, click the Apply button to
save the change. The quickest way to open File Explorer Options in Windows 11 is via search. Click the Search icon on your Windows 11 taskbar and type “file explorer options” (without the quotes). Then, left-click File Explorer Options from the search result to open it. Impressively, you can also open File Explorer Options in Windows 11 via the
control panel. Follow the steps below to do that. Click the Windows 11 Search icon and type “control panel” in the search field. Then, select the Control Panel from the search result. After that, click the View by drop-down and select Small icons. Finally, select File Explorer Options. Apart from opening File Explorer Options via search and control
panel, you can also open it via File Explorer. To do that, click the See more icon in the File Explorer window and select Options from the displayed options. File Explorer in Windows 11 has a preview pane. If you enable the preview pane, you will see a preview of the content you selected in File Explorer. So, follow the steps below to enable the
Windows 11 File Explorer preview pane. Click the View menu on the File Explorer window and hover your mouse cursor on Show. Then, select Preview pane from the displayed options. Hence, anytime you select a file, Windows 11 File Explorer will display a preview on the window’s right pane. 1. Is File Explorer different in Windows 11 compared to
Windows 11? The functionality of File Explorer in Windows 11 and Windows 10 is totally the same. However, their user interfaces are different - read Windows 10 vs Windows 11: File Explorer to know more. 2. How do you open File Explorer in Windows 11? Follow the steps below to open File Explorer on your Windows 11 PC. a) Click the Windows
11 Search icon on the taskbar. b) Then, type “file explorer” in the input field.c) Finally, select File Explorer from the search result. 3. When was File Explorer introduced? Windows File Explorer was introduced on 15th August 1995. 4. What is File Explorer? File Explorer, formally known as Windows Explorer, is a file manager app that is included in
Windows computers. Furthermore, it allows you to browse files and folders on your Windows PC. 5. What is the shortcut to open File Explorer in Windows 11? The keyboard shortcut to open File Explorer in Windows 11 is Windows key + E. File Explorer in Windows 11 is a useful app that allows users to browse folders and files. However, some people
might find it difficult to access Windows 11 File Explorer’s features. Gladly, this Get Help With File Explorer In Windows 11 article fixes that. This guide explained how to use most of the Windows 11 File Explorer features. As a matter of fact, we discussed various methods to open File Explorer in Windows 11. Also, I provided numerous Windows 11
File Explorer keyboard shortcuts in this guide so as to boost your productivity. All in all, with this guide, File Explorer in Windows 11 has never been easier to use! Did you find this Windows 11 File Explorer help guide helpful? If you find it helpful, click on “Yes” beside the “Was this page helpful” question below. You may also express your thoughts
and opinions by using the “Leave a Comment” form at the bottom of this page. Finally, visit our Windows 11 How-To page for more Windows 11 how-to guides. Was this page helpful? Yes (1)No (0) About the Author Oluwaseun Bamisile Related Articles We're committed to writing accurate content that informs and educates. To learn more, read our
Content Writing Policy, Content Review Policy, Anti-plagiarism Policy, and About Us. However, if this content does not meet your expectations, kindly reach out to us through one of the following means: Respond to "Was this page helpful?" above Leave a comment with the "Leave a Comment" form below Email us at [email protected] or via the
Contact Us page. Among tons of visual changes and new features, Windows 11 completely overhauled the File Explorer app to make it more productive than ever. To help you master it, we have picked the best Windows 11 File Explorer tips, tricks, and hidden hacks to harness its useful features. Stick with this guide till the end to make the most of it.
Additionally, you can learn to fix the File Explorer app on Windows 11 if it is not responding.Top Windows 11 File Explorer Tips, Tricks, and Hidden HacksBelow we have curated the list of the best Windows 11 File Explorer tips, tricks, and hacks to master them in no time. So without any further adieu let’s get started.Maximize Productivity by
Arranging Apps in GroupsSimilar to the Android’s split screen feature, the Windows file explorer app allows you to arrange and use multiple apps (in a group) on a single screen in Windows 11. Consequently, you can group up to four different apps on a single screen. Here’s how:1. Open the File Explorer app and hover your mouse cursor over the
Maximize/Minimise Window icon to see predefined group layouts.2. Next, pick your preferred grouping layout and open your desired app inside each split window to use them simultaneously.Open Multiple Tabs in Windows File ExplorerGone are the days when you had to open a separate window to access each file. Now, you can open multiple tabs
inside a single File Explorer window to conveniently navigate and access your files like a web browser. Here’s how to use it:1. Open the File Explorer window and click on the + icon to open a new tab.2. Next, browse and access your desired file in the newly opened tab. You can switch back to the previous directory by pressing the former tab.Change
Default File Explorer LocationWhen you open the File Explorer app, it opens the Home tab by default, making it irritating to manually access disk drives on the “This PC’ tab each time. Luckily, you can change it by configuring the File Explorer settings. Here’s how:1. Open the File Explorer app and click on the three-dot icon next to the View tab to
access Options.2. Now, click the ‘Open File Explorer to‘ option and set it to “This PC’.3. Finally, press the Apply button to save changes.Control Privacy for the Quick Access MenuThe Quick Access menu in the Windows File Explorer app has the ability to show frequently or recently used items on your system. If you share your system with your
friends/family, at times you might feel uncomfortable disclosing this recent information. Luckily, the updated file explorer app allows you to exclude it. Follow these steps for an easy fix:1. Open the File Explorer app and click on the three-dot icon next to the View tab to access Options.2. Here, toggle off the checkboxes for ‘Show Recently Used Files’
and ‘Show Recently Used Folders’.3. Finally, press the Apply button to save changes.Show/Hide File Name ExtensionsBesides quick access, the File Explorer app in Windows 11 allows you to show/hide extensions next to the file names to facilitate easy identification. Here’s how you can enable or disable the same:1. Go to your desired file directory
with the explorer app and click on the View tab at the top.2. Hover your mouse cursor over the Show option and click on File Name Extensions to enable it.3. You can now see extensions next to each file name in the directory. To disable the extension, repeat the same steps.Personalize Folder and File AppearanceSimilar to Windows 10, you can
change the appearance of files and folders in Windows 11 to make them more readable. Follow these easy steps to personalize the same:1. Open the File Explorer app and click the View tab in the toolbar at the top.2. Next, choose your desired icon size from the list to increase readability. An extra large icon size will show the entire image/folder as a
preview thumbnail, while a small icon size will conserve the space to view more items.3. Similarly, you can pick from four pre-defined layouts, namely, list, details, tiles, and content, to organize files and folders inside a directory.You can also follow our guide to Install the macOS “Quick Look” Feature on Windows to help you easily view a file’s
contents without actually opening it.Rotate Images without Opening ThemWith the new File Explorer update in Windows 11, you can rotate images without opening them. In addition, you can select multiple files in bulk to rotate them instantly with a single click. Here’s how:1. Select your desired image(s) using the file explorer app and click on the
Rotate button in the toolbar at the top. You can either rotate the image to the left or right by clicking their respective buttons.2. Once rotated, you can preview the image using the file thumbnail without opening it.Change System Background with a ClickSwitching to a new system background is as easy as eating a cake with the new Windows file
explorer app. Simply select the image you wish to set as your background and then click the Set As Background button at the top to apply it.A Versatile Right-Click Context MenuThe new File Explorer app in Windows 11 intelligently recognizes the file type and provides useful suggestions to handle it. Consequently, the context menu differs based on
file type to manage each file and folder in the directory. In addition, the menu offers quick toggle buttons for cutting, pasting, renaming, sharing, and deletion in its header or footer section to save you precious time. However, if you prefer the old right-click context menu (like Windows 10) instead of the new UI, you can check out our guide to get
back the old right-click context menu on Windows 11.More Powerful Search Bar than Ever BeforeBesides searching individual files, the new search bar in the Windows 11 file explorer app can search similar file types with a keyword. For example, if you type ‘folder’ in the search bar of a file directory, you will view all the folders inside it. Similarly, if
you type ‘Image’ in the search bar and hit the enter key, the file explorer will show you all the image files present in your searched directory. This can be useful when you are searching for a similar file type among the vast ocean of files and folders in your directory.Select Multiple Files with CheckboxesOften while selecting multiple files, we
accidentally drag the mouse cursor or release the control key, losing the focus of the selected items. Not anymore; as the new File Explorer app on Windows 11 now offers the checkboxes feature enabling you to select multiple files by clicking the checkbox located at the top of each item. Here’s how you can enable it:1. Navigate to your desired file



directory and click on the View tab and enable the Item CheckBoxes under the Show feature.2. To select multiple items using the checkbox, hover your mouse cursor to the top-left corner of each file icon and click the checkbox button to select it.3. Repeat the above step to select multiple files in your current directory.Rename Files in Bulk in Windows
File ExplorerWhile organizing screenshots or photos, we feel the need to rename them. Normally, you have to follow the time-consuming process of right-clicking each photo to rename it, but what if there’s a quick way to do it? With Windows 11, the file explorer app allows you to rename one file and press the Tab button to rename the immediate
next neighbor. You can repeat this process quickly to rename multiple files sequentially.Preserve Screen Space with the Compact ViewlIf you feel that the new File Explorer Ul has too much padding between items, you can switch to the Compact layout to save space and view more items on a single screen. This can be useful for your vertical screen
setups. Here’s how it can be done:1. Press the View tab in the toolbar at the top and click the Compact View option to enable it.2. Notice that the padding between items in the left sidebar and filenames has been decreased.Share Files Directly from the ExplorerSharing files with Windows 11 File Explorer is super convenient and quick. Right-click on
your desired file and press the Share icon to send it to nearby devices or connected apps. You can also share it with the Feedback hub or Microsoft Teams for quick communication.Increase Productivity with File Explorer HotkeysLast but not least, you can master navigation through the Windows File Explorer app with these hotkeys/shortcuts:FAQsQ:
How to change Windows 11 File Explorer layout?A: You can access the View tab at the top to change the layout of files in the Explorer app.Q: Where can you access the settings for the Windows 11 File Explorer app?A: Simply press the three-dot icon next to the View tab and click on Options to access the File Explorer app settings.Q: How to change
the file icon size in the Windows 11 Explorer app?A: Click the View tab and choose your desired icon size in the list to improve readability. Refer to the above tips for detailed steps.Q: How to print a document from File Explorer in Windows 11?A: Right-click on the file and click on the Show More option in the right-context menu. Here, you will find
the option to Print your document.Wrapping Up: Become a Pro with Windows 11 File Explorer Tips!We hope you’ve picked some useful File Explorer features of Windows 11 through this guide, some of these features work on Windows 10 as well, or you can get Windows 11 file explorer on Windows 10. If you find it helpful, share this read with your
friends to boost their productivity to the next level. Stay subscribed to GadgetsToUse, and check the below links for more interesting Windows 11 walkthroughs.You might be looking for the following:You can also follow us for instant tech news at Google News or for tips and tricks, smartphones & gadgets reviews, join GadgetsToUse Telegram
Group, or for the latest review videos subscribe GadgetsToUse Youtube Channel.Was this article helpful? File Explorer is a fundamental part of the Windows operating system, serving as the primary interface for managing files and folders. Whether you’'re navigating through your documents, seeking specific files, or organizing your digital workspace,
understanding how to effectively use and troubleshoot File Explorer is essential. In this detailed article, we will explore various aspects of getting help with File Explorer in both Windows 11 and Windows 10, from the built-in support resources to third-party solutions. Understanding File Explorer Before delving into getting help with File Explorer, it’s
critical to grasp what it is and its significance. File Explorer (previously known as Windows Explorer) allows users to: Navigate their file system effortlessly Organize files and folders Access network storage Manage cloud storage (e.g., OneDrive) Share files and folders with others Knowing how to utilize File Explorer efficiently can make a
considerable difference in your overall user experience. Common Issues with File Explorer While File Explorer is a robust tool, users often encounter issues from time to time. Some common problems include: File Explorer freezing or crashing Issues with search functionality Slow performance when opening or navigating folders Problems with file
previews and thumbnails Missing or corrupt files Understanding these common issues will assist you in targeting your troubleshooting efforts effectively. In-Built Help Options in Windows 11 and Windows 10 1. Windows Help and Support Both Windows 10 and 11 come equipped with comprehensive help resources. You can access this feature by:
Pressing the F1 key within File Explorer. This will launch the official help documentation in your default web browser. Going to Settings > Help to access additional resources. The help menu includes articles related to common tasks, troubleshooting, and best practices for using File Explorer. 2. Quick Actions in the Toolbar File Explorer features a
Ribbon tool at the top, which includes various functionalities. If you need assistance, look for the View tab, which allows you to customize your file management experience. You can enable features such as: Previewing items Enabling hidden items Changing folder options Taking time to explore these features can enhance your understanding and
efficiency in using File Explorer. 3. File Explorer Options If you're facing usability issues or specific quirks in how File Explorer operates, exploring the File Explorer Options can help. Open File Explorer. Click on the View tab in the Ribbon. Select Options. From here, you can modify settings related to how folders and files are displayed, tweak file
path behavior, and change advanced settings that dictate how File Explorer interacts with your files. 4. Windows Search Bar The search feature available in both Windows 10 and 11 can be invaluable when trying to find help regarding File Explorer issues. By typing keywords into the taskbar search bar, you can quickly access articles, forums, and
even settings related to your query. 5. Windows Feedback Hub If you're encountering issues not covered in the help resources, consider using the Windows Feedback Hub: Press the Windows key + F to launch the Feedback Hub. Report your file-related issues for potential fixes or workarounds. This tool allows you to see if others have similar
problems, and Microsoft often responds or issues patches for common conundrums. Utilizing the Microsoft Support Website Microsoft’s official support website is an excellent resource for troubleshooting and getting advice related to File Explorer issues. Here’s how to navigate it: Go to support.microsoft.com and enter “File Explorer” in the search
bar. Scour through the articles, FAQs, and guides available. Use the community forums to engage with other users who may have faced similar issues. These resources often include step-by-step instructions to resolve common problems, tips for optimizing performance, and even video tutorials. Community Forums for Support The Windows
community forum is another vibrant place to seek help. Here are a few steps to follow: Visit the Microsoft Community page. Search for your particular File Explorer problem. Engage in discussions or create a new post if you cannot find an existing solution. Community members, including Microsoft MVPs and avid users, often provide helpful insights,
fixes, and shared experiences. Advanced Troubleshooting TechniquesUpdate Drivers —Fix Your PC - If standard support does not resolve your File Explorer issues, consider advanced troubleshooting techniques. 1. Running the Windows Troubleshooter Windows includes a built-in troubleshooter to help identify and fix common system issues,
including those that may affect File Explorer. Go to Settings > System > Troubleshoot > Other troubleshooters. Locate File and Folder Troubleshooter and run it to diagnose any potential issues. 2. Resetting File Explorer If File Explorer consistently behaves incorrectly, you may want to reset it: Open the Task Manager by right-clicking the taskbar
and selecting it. Find Windows Explorer in the list of processes. Right-click it and choose Restart. Resetting can often clear temporary glitches that cause performance issues. 3. Checking for Windows Updates Often, issues with File Explorer can stem from outdated software: Go to Settings > Update and Security > Windows Update. Check for any
available updates and install them. Updates may contain patches and fixes that resolve existing problems. 4. Execution of System File Checker Sometimes, system files associated with File Explorer can become corrupt. To restore these files, execute the System File Checker (SFC): Open the Command Prompt as an administrator. Type sfc /scannow
and press Enter. This process can take some time, but if it finds any corrupted files, it will attempt to repair them automatically. 5. Rebuilding the Search Index If your search functionality is sluggish or unresponsive, consider rebuilding your search index: Go to Control Panel > Indexing Options. Click on Advanced and then select Rebuild. This
process can help improve search accuracy and speed in File Explorer. Using Third-Party Tools Sometimes, Windows’ built-in tools may not address all your needs. When that happens, third-party software can provide alternative solutions. 1. File Management Tools Several third-party file management tools offer extensive features beyond what File
Explorer provides. Programs like Total Commander or Directory Opus allow for multi-pane views, tabbed browsing, and enhanced file preview options. These tools often have extensive support documentation that caters to various user needs. 2. Cleaner Software File Explorer issues can arise unless your system is adequately maintained. Cleaner tools
like CCleaner can help tidy up unwanted files and optimize system performance, potentially easing problems with File Explorer. 3. Community-Created Scripts and Tools The tech community often creates scripts or small utilities designed to enhance or troubleshoot File Explorer. Websites like GitHub host numerous projects that can be downloaded
for specific file management needs. Frequently Asked Questions (FAQs) Why does File Explorer keep crashing?Driver Updater - Update Drivers Automatically — File Explorer crashes can often result from software conflicts, corrupted files, or plugin issues. Running the SFC scan or resetting File Explorer may help. How can I troubleshoot the search
function in File Explorer? To troubleshoot search issues, rebuild the search index, check for updates, and ensure your Windows settings are correctly configured to allow indexing. Is there any way to customize the File Explorer interface? Yes, you can customize File Explorer by changing the layout, modifying ribbon options, or selecting which folders
display in Quick Access. What should I do if I can’t find a file? Use the built-in search feature of File Explorer, and ensure you check in hidden and system folders if necessary. Utilize external search tools if needed. Can I repair File Explorer without reinstalling Windows? Yes, running the SFC command, resetting File Explorer, or performing a system
restore can often fix problems without a full reinstall. ConclusionUpdate Drivers —Fix Your PC — Getting help with File Explorer in Windows 10 and 11 encompasses understanding built-in tools, leveraging community resources, and using advanced troubleshooting techniques. From engaging with Microsoft’s support to exploring third-party tools, a
wealth of options is available to enhance your experience and resolve common issues. By actively utilizing the resources and techniques outlined in this article, you can optimize your Windows file management experience, ensuring that File Explorer becomes a reliable ally in your daily productivity tasks. Never hesitate to reach out for help, whether
through Microsoft’s official channels or user communities, because effective file management is crucial in our increasingly digital world.



